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Overview 

Some of these tips you may already know, they may have been taught in a class 

study. If they have then you can skip the tip but at least it remains as a memory 

jogger when there is no tutor at your side. Also you may have been taught how 

to do the operation contained in the tip but have now forgotten. The tip may not 

have been included in the manual supplied with the course – it may have been 

passed on by the tutor to you personally and at the time you didn‟t take a note 

on it. Any tutor reading any of these tips should bear this in mind when you read 

one that is taught in your lessons. 

Zoom View 

Ever find yourself staring at a section of an Excel worksheet and feel as if 

you‟re going cross eyed? All those cells and numbers... I can feel your headache 

starting not to mention some migraines.  

Try this quick way for making sense of that sheet.  

 

Excel is full of functions one of which is zoom. It will automatically zoom in on a 

selected range of cells – something like turning the following cells produced 

 

 
 

into this a bigger view following.  
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As these zooming options are available in both older and newer versions of Excel 

and I have notes on the older one I‟ll include them. 

 

Start by selecting only those cells that you wish to view. 

Select the Zoom choice by selecting View -> Zoom. 

You will see the zoom box shown below 

 

 
 

Click Fit selection and then OK. 

To get back to the original size just reverse the operation. 

One trick I use in this situation is to not do any editing here then you can just 

use the general undo command CTRL + Z key combination. One of the beauties 

of learning these keyboard short cuts is that they work in just about all of 

Microsoft‟s application programs and normally are carried over from one version 

to the next.  

 

Zooming For Excel 2007. 

As before select the cells you need to zoom. 
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On the View tab of the Ribbon click the Zoom to Selection button. 

 

 
 

Use the Zoom to select the size you require, the Zoom box looks exactly the 

same as it always has done see screenshot above. 

Make your selection. To return to the original selection again, use the Zoom to 

Selection button again or Ctrl + Z. 

Caution: Do not use the Ctrl + Z key combination if you have don some 

editing while zoomed – Ctrl + Z reverses the last piece of editing entered. 

What could be easier to stop that eye squinting and headaches? 
 

Using The Concatenate Function 

Ever had the following type of spreadsheet? 

 

 
 

You want to change the B and C column around so that you can have the first 

name followed by the last. You‟d also like the two columns merged into one. But 

you don‟t bother because you either don‟t know how, or it seems like too much 

bother. There is a Function to do this – I don‟t know if this works in versions 

earlier than 2007 but try it and see. 
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The function is called Concatenate. It works like this: 

=CONCATENATE(B1," ",C1) 

 

 

 

What that has done is to place the Last Name 

and 1st name in one column but they are still not 

in the order you require 1st Name Last. 

That‟s not a problem let‟s turn the formula 

around. 

=CONCATENATE(C1," ",B1) 

 

 

 

I have widened up the E column to show that 

the data is indeed in one column and also that 

the names in the columns have been reversed. 

Obviously the formula has to be copied down 

the sheet to change the whole column of data. 

Now to get the data back into the original 

column. 

 

 

 

 

 

 

If you do a copy and 

paste you will copy over 

the formula and doing 

this will confuse Excel 

and make a mess of 

thing. So, highlight the 

cells of data to be 

moved in this case it 

will be E1 to E12. 

Use the Ctrl + C key 

combination to copy the 

data to the clipboard.  
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Move the cursor to cell A1 and widen the cell in order to 

accommodate the new double column of data coming in. 

Click the downward pointing arrow in the Paste button  

You can either use the Paste Values button and click on 

it or use the V key (which is underlined and therefore 

the shortcut key) 

Now delete the data in column B and Column E 

That‟s it you‟re done. 

This is making use of Functions (this one is the 

Concatenate Function and is a very handy one to have in 

your repertoire of tricks for Excel.)  

 

 

 

 

 

What’s A Data Bar? 

This is something quite new in Excel 2007 and it‟s a very handy tool to have – it 

may not be used very much by our own SeniorNet members, but some of you 

that are still in business may find it very handy. The example I‟m going to give is 

simple I‟ve done it just to give you an idea of how it works. Here‟s the scenario – 

in a spreadsheet you have electricity amounts for the year beginning Jan 

through to Dec and you wish to know with a quick glance which are the highest 

months and the lowest. This is fairly easy to follow because we know that the 

months of Apr through to Sep should be the highest in the year. But this could 

be a column of variable income where there is no set pattern. This is the Sheet. 

 

  This is the problem how can we tell at a glance, which 

are the highest and lowest figures? Yes, you could sort 

the data but that would upset the months‟ listings. 

What we can do is use the Data Bar option available in 

Excel 2007. By doing so this is what we would see. 
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This is a different kettle of fish. Just by glancing down 

the list we can see that Aug was the highest month and 

Feb was the lowest month. The amount of colouring in 

the data bar guides your eye to these places. 

 

So how do we do it? 

First highlight the column of data. 

Then select Conditional Formatting -> Data Bar 

Move to the right and select the colour to use In this 

case I‟ve used green but there are plenty of colour 

selections to choose from. That‟s it you‟ve seen what you 

wanted too, now to change it back to normal. Make the 

highlight of the data again. 

Select the Conditional Formatting again. 

Select Clear Rules 

Select Clear rules from selected cells. 

As stated here I‟ve selected only 12 pieces of data but this could be done where 

the data is 100 or more rows deep. 

Using the Ribbon Another Way 

If you have MS Office 2007 or 2010 you know by now that the menu and 

toolbar has gone being replaced by the Ribbon. Most users found it quite 

confusing when first getting used to it but, now you accept it and like most of 

us, occasionally still get confused. But boy oh boy is it big and a real screen area 

grabber. So what I do is to minimize it, have any of you tried doing this?  

Most users leave it “as is” while others like me minimize it. But let‟s think about 

that for a minute or two; how do you do it? 

The way to minimise the Ribbon is to either use the down arrow on the right 

side of the Quick Access Toolbar or do it by right-clicking on the ribbon itself 

and the click the Minimise or Maximise the ribbon choice whichever is the one 

available. That means two clicks of the mouse, a right and select the choice, 

then a left click. This can be a hassle if you keep flipping backward and 

forwards doing this I know that most users give up doing this and leave the 

ribbon as it is – fully displayed. 

Now for the quick and easy way to maximise or minimise that Ribbon, there 

usually is one and I found it purely by accident, it pays dividends to play with 

programs  when something happens that you didn‟t do on purpose. In future 

when you wish to revert to one of these choices do the following. 

Use the Ctrl + F1 key combination. Go on try it now, hold down the Ctrl key and 

type the F1 key. Isn‟t that easy want to go the other way? Ok do it again - sit 

there and play with it for an hour or two, well a couple of times anyway. There‟s 
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a bonus to this – it works in any Office 2007 program, “And not a lot of people 

know that” as Michael Caine would say. 

The other added bonus is that with the Ribbon minimised the QAT (Quick 

Access Toolbar) remains visible under the menus, clicking on a menu will drop 

just that ribbon and when you click back in the document the Ribbon again 

reverts to the minimised state. 

*********************************** 

Fill Cell Contents Without Using the Fill Handle 

The bottom right corner of a cell selection is called the Fill Handle. It‟s a pretty 

useful tool to have in the toolbox of Excel. But it can be exasperating to use 

where the column is deeper than say 20 lines or so. You get cramp from hanging 

on to the mouse with the left button held down all the time you are dragging 

away. Sometimes you wish there was an easier way – well let me advise you that 

there is, and I‟ll show you how to do it.  

 

 

  This is the handle normally dragged while the left 

button is depressed. 

When you want to drag this button you will find as 

you use the cursor pointer the mouse pointer turns 

to a small cross, normally once you see this you drag 

it downwards until you have filled in the months 

down to where you need to. 

Point to this small corner object until the cross 

hairs appear – Don‟t drag the pointer just double 

click it. Your spread sheet column will fill until it 

reaches a gap in the data in the column on its right. 

As shown here. 

This method of filling is not limited to data fills. 

Let‟s suppose you have to fill a column with a formula the same thing can be 

done. Enter the formula in the top cell double click the call in the corner as you 

do when there is data and the formula will be copied down as far as is 

necessary. 

In October last year a Taxi driver asked me to change his tax in the year from 

12.5% to 15.00% for the period Oct to March all I needed to do was change his 

12.5% formula to a 15.00% formula and fill it this way to the bottom of the 

sheet. For those that haven‟t worked it out that‟s 182 rows of formula in one 

column. 
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Auto Fill One Cell  

This tip is more useful than would at first appear. Sometimes we find ourselves 

having a list of data that is not the same as above but does have some of the 

same data. Take a case of a list of names sometimes in a column of names the 

same name could be repeated three or four times. Look at the list below.   

 

Suppose that I need to repeat some of these names lower down 

the list, what I could do is select the ones I need and do a copy 

and paste or retype the name a second time but in fact I don‟t 

need to do either. Move to the cell below the and right click it.  

 

 
 

 

 

 

 

 

 

 

You will see a list of names as above after clicking on 

the select “Pick from list” from the menu. 

You can move up or down the list by using the scroll 

bars, select the name you want and click it, it will be 

pasted automatically into the empty cell. But there is a 

quicker way to use this trick click on the next empty 

cell in the column and use the Alt + Down arrow key 

combination and the same list appears and can be use in 

the same way. 

 

Once you have the names that you want you can move 

them down or up to a different place or even a 

different column; sometimes you may wish to leave 

them as they are it‟s up to you – but always get the 

names first. 
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Deleting Separate Rows  

Have you ever been in the situation where you have deleted something in a cell 

and it‟s the only thing in that row of data? You decide to get rid 

of the row so you use the delete row option. 

 

In the case on the left we have deleted the data in the rows 

affected now it‟s decided to get rid of the empty rows. What‟s 

the next step, select the rows one at a time and use the delete 

button? That will accomplish the desired result but what does 

that mean in reality? Its three clicks for each row. That means 

clicking on the row‟s cell once moving the mouse over to the right 

side of the screen and clicking on the Delete button then 

selecting Delete Sheet Rows. It also means that you have to click 

the little downward pointing arrow in the Delete option in order 

to drop the options. So we have to do all this three times in the 

current worksheet. Suppose we had 30 rows to delete what then 

do we repeat the operation 30 times? The answer is not if you‟re smart, have a 

look at that option again it says, “Delete Sheet Rows” – rows is a plural so what‟s 

with the one at a time thing? Do it this way: 

Select the first row to be deleted and click on the cell. 

Move to the next row and hold down the Ctrl key before clicking on the cell. 

Do this until all the rows you want to delete are selected. 

Move to the Delete button and from the selection select Delete Sheet Rows. 

That‟s it now you‟re cooking with gas. This method is also available for more than 

single column deletions that contain unwanted data. 

NOTE: When deleting a row or column, remember it‟s like carrying a ladder on 

your shoulder, it has more than the end you can see. Make sure before any 

deletion of this nature that there is no data currently out of sight that you do 

or will need later in your calculations.    

 

Fractions in MS Excel 

Do you remember from your school days Fractions? I don‟t know if children 

these days have o or even still do fractions – I bet if they do they will still be 

looking for that common denominator! Ok have you ever found yourself working 

in MS Excel and needed to enter data as fractions, if so what did you do? 

What many of us do is make them into a formula by dividing the denominator 
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into the numerator and adding the whole number to the resultant decimal 

because all fractions can be expressed as a decimal. In fact when I served my 

time as a Toolmaker we were expected to know how to convert in our heads 

fraction of an inch into a decimal so that we could read a micrometer 

measurement correctly and convert them back again. 

Entering fractions the way described above works, but only if it‟s not necessary 

for the fractions to be maintained, in other words I don‟t need to display the 

answers as fractions. So, what if is necessary? We could make the fraction into 

text but doing this will not allow us to calculate with them. Let‟s then have a 

look at working in Excel with the fractions, and get the answers returned to us 

in fractions. 

 

When needed a mixed number can be entered into an Excel cell by simply typing 

this:  

The whole number 

Followed by a space 

The fraction numerator 

A slash (/) 

The fraction denominator 

 

What you should see in the cell for say two and a quarter is: 

 

 
 

If you want to see the decimal equivalent, look in the formula bar it‟s 2.25. 

 

 
 

How did I enter 3/16 as a fraction? Simple type zero followed by a space 

followed by 3/16 Excel displays .1875, which is the decimal equivalent. 

These are known as simple fraction if you remember them from school but some 

of the kids I went to school with called them anything but simple. 
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Without the whole number 0, Excel thinks you are entering a date 

 

It‟s possible to get Excel to carry out mathematical operations on the fractions 

in the same way as we used to when we were at school. A glance at the next 

screen shots will show you this. 

 

The three E cells added. And below multiplication 

 

 

 

 

 

 

 

  

 

 

Add Explanation Information to Excel Formulas 

Ever find yourself working on an Excel sheet a long time after you designed it 

and wonder what or why you placed a formula into a cell? In writing programs 

for computers it is imperative that you add comments directly before or after a 

process – this allows anyone that has to maintain the program after you have 

left what the process does. So you cab write a long document explaining what 

each formula does or comment the formula when you put it in place. 

You do not need to add the comment behind a formula for every one on the 

spreadsheet, most of them will be obvious. There will be the odd cell where the 

formula is more ambiguous as to the reason it is there or, what it actually 

achieves in relation to the sheet overall.  

Start by entering your formula. 

Test the formula out for correct calculation etc. 

Once you are satisfied return to the cell and edit the formula in the following 

way. 

After the end of the formula place this into the formula text box. 

+N(“Your explanation”) 

I‟ve shown an example of this in our now familiar fractions spreadsheet. 
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In the above the formula explanation is +N(“Multiplies cell B1 by C1”) 

This is pretty obvious but you get the idea. 

The above addition to the formula doesn‟t alter the result in any way. Remember 

to place the inverted comas around the text inside the brackets.  

 

Add & Delete Excel Columns the Easy Way 

I get tired of looking for the correct button on the Ribbon or command from 

the Insert menu and I bet you get frustrated also. Here's an alternative you 

might find better and easier to use. 

Highlight the number of rows or columns you want to insert. Make sure you 

highlight the row below or the column to the right of the insertion. 

 

Now it's as simple as Ctrl + Shift + =. 

I wish to add three columns between C and D 

 I highlight the 3 columns D:F 

  
 

I use the Ctrl + Shift + = and the following happens. 

 

I now have the 3 columns that I require between columns 3 and 7 but they have 

taken the names D, E, F and column 7 and 8 are now in columns G and H. 
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To remove rows or columns do the same highlighting procedure and then use Ctrl 

+ - 

That‟s it they are added or gone as the case may be. You never looked for a 

single menu or Ribbon and never clicked any item either. The computer has to 

work for you not you for it. 

Caution: The above method actually inserts or deletes the columns it does not 

Hide and Unhide them. 

Moving Backwards 

Sometimes in Excel it‟s necessary to move in the opposite direction that the 

cursor moves when the enter key is typed. I can bet that you used the arrow 

key or worse still the mouse to get to the correct cell. On average most people I 

have observed do this. 

This works, but there‟s a better and more efficient way to do this. 

Next time you need to do this, try the Shift + Enter key combination instead of 

just Enter. 

You'll find that your data is entered into the cell and the cursor has moved up 

instead of down. It‟s possible to change the direction the cursor moves by using 

the Options dialog box. Using Shift + Enter moves the cursor in the opposite 

direction to the one selected. 

Double-Click to AutoFit 

As many MS Excel users know, you can highlight a column and with the Format menu, 

Column sub-menu choice (Excel 2007 it's on the Home in the Ribbon, Cells section, 

Format button), you can choose the AutoFit Selection option. This makes the column 

wide enough to fit the longest piece of data in the column. No guesswork is needed in 

order to make the data fit the column. But there is a quicker way to do this with a 

simple double click no looking for the right piece in the ribbon. 

Follow this example. 

In the following screen shot the data typed in has remained as it should in cell A1 but 

has spilled over to the next door cells 

 
 

Place the cursor on the divider line between the columns A and B and double click, the 

column does its own spacing. 

Place cursor 

here 
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Fill Cell Contents Without Dragging The Fill Handle 

In MS Excel the bottom right corner of a cell selection is called the Fill Handle it‟s 

shown in the screenshot below. If this is picked up by holding down the left mouse 

button and dragged down the column the formula will be copied to the cells below with 

the correct cell references. It‟s basically a Drag „n Drop procedure. What if there were 

40 items or 400 in the column are you going all the way with this method? What about 

doing the Ctrl + Enter thingy won‟t that work? Yes it will but are you going to highlight 

400 rows in the column to use it? 

 Do it this way. 

Enter the formula (or data) that needs to be filled down the column into the top 

cell. 

Hit Ctrl + Enter (keeping in the cell with the data selected.)  Double-click on the 

fill handle the fill will fill down the column until there is a break in the 

consecutive column. Even if the answer to the formula is zero as shown below. 

 

 

 

 

 

 

 



3 Page 17 

 

Merge Without Centering 

In Excel the Merge & Centre command is a handy thing to know about and use. It allows 

selection of multiple cells then by using the Merge & Centre command the cells are 

merged into one large cell with the cell being centred. 

With it table titles centred above the columns of data.  

What happens where you wish the cell contents to stay in their current format? Well, 

you can Merge & Centre followed by the left justification. But never let the computer 

make you work for it it‟s there to work for you. 

Unfortunately that is the only way to do it with Excel up to version 2003. But with 

Excel 2007 that all changes.  

As usual begin by highlighting the cells to be merged. 

On the Home tab of the Ribbon  

Select the Merge & Centre button 

Don‟t click it or press the Enter key 

Just click the downward pointing arrow on the right side of the Merge & Centre 

button. 

 

From the list that opens choose Merge Across. 

The merged cells are not centered like they normally are 

because any justification  

 
  

  

 

 

Transfer Page Setup Settings  

Transferring page setup information from one sheet to another can be a real 

pain in the neck or can be a doddle. 

Often we‟ll set up a worksheet and later realise that another one is needed in 

the same workbook with exactly the same settings. I can hear the comments 

now –„Bin there dun that!‟ 

When you add a sheet along with it come the default settings for a workbook 

sheet 

and none of us look forward to doing all that work of set up again. But as always 

there is an easy answer to the problem. This trick may turn into a big time 

saving device for anyone who finds themselves with this problem. 

 

The settings can be transferred from one worksheet to another with some 

quick clicks here‟s how it‟s done. 

Select the worksheet tab that already has the page setup.  You must select the 

setting to be copied sheet first 
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Now select the tab of the worksheet or sheets (more than one is possible) to which the 

transferred settings need to go to. 

Think of them this way: 

Page from The Source Page 

Page to which it is going The Target Page.  

Now open the Page Setup dialog box. 

For older versions of Excel it's on the File menu.  

For Excel 2007 you can use the dialog launcher for the Page Setup section of 

the Page Layout tab of the Ribbon. 

 

 

 

 

Page layout Setup        

icon 

 

 

 

Regardless of your version, once the Page Setup dialog box opens click OK. 

The first sheet selected is the source for the Page Setup settings found when 

the dialog box opens. On clicking OK those settings will apply to all target 

sheets that have had their tabs selected. 

 

Print Only This 

Problem: Excel always tries to print everything the worksheet. There‟s no 

problem with this for the bulk of hard copies we want but there are times when 

you only want a small area printed. This normally happens when the worksheet is 

large and you only need a small section of it. This could be for presenting a 

listing of figures to a group that doesn‟t need all the separate working to be 

shown. 

You could set up the workbook so that the part needed is on a separate 

worksheet but you need to make sure that both sheets have the same 

information by binding one sheet to the other. If it‟s not on a separate sheet 

then do the following:  

Use the Print area method:  

Highlight the cells you want to print. 

Depending on your version of Excel set the print area 

In older versions of Excel:  

Go to the File menu, Print Area, select Set Print Area from the submenu.  

Excel 2007: 

Go to the Page Layout tab of the Ribbon  
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Print Area button, Set Print Area. 

It really is that simple, now, when you print, you'll only print the highlighted 

cells you selected. 

If you try using the Ctrl key to select separate sections of the print area. Excel 

prints each section on a separate sheet of paper. Not what‟s wanted at all! 

 

Second thoughts on this might occur to you – what about when I need to print 

the whole sheet again?  Well, actually there‟s no necessity to even have to 

highlight the cells 

Use the same steps as above except this time choose clear the print area. 

 

Older version of Excel:  

File menu, Print Area and select Clear Print Area from the submenu. 

Excel 2007:  

Go to the Ribbon Page Layout, Print Area button, Clear Print Area choice. 

Things are now back as they were before. 

This is another one of those things that you would do well to log in your Change 

Control Log. Else later when you come to print the whole worksheet you may 

begin to wonder what‟s wrong! 

 

Need a Quick Calculation 

I know that sometimes when I'm working in Excel I need a calculator. I know 

there are heaps of you wondering why I'd need a calculator when Excel can 

basically do all that for me. After all isn‟t it a number cruncher? That‟s true but 

sometimes it's easier to punch a few numbers into a calculator than it is to 

write a formula. If you agree then in Excel 2007 it‟s possible to add the 

Windows calculator into the Quick Access Toolbar. 

Now if a calculator is needed it‟s there right in the Ribbon.  

What‟s more if  you close the thing when you think that you're finished only to 

find a couple of minutes later that you still need it it‟s still where it was before 

on the Ribbon there‟s no need to go to the Start menu.  

So, here's what you need to know to add the Windows calculator to your Quick 

Access Toolbar. 

To get it on the Ribbon do the following 

Open up the Options dialog box to the Customize section. 

Either right-click on the Ribbon and choose Customize Quick Access Toolbar  
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Or click the Office Button  

Select More Commands… 

 

 
 

Either way, you should be looking at this: 

 

 
 

Choose Commands Not in the Ribbon. 
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Click the downward pointing arrow on the right side of the text box for this. 

Select Calculator from the list (the list is in alphabetical order) 

Click the Add button in the center. 

Click OK. 

You must have the ribbon displayed to see this. 

   

 

MS Excel 2007: Setting the Default Font 

For many of us the font used in our documents, presentations and workbooks is 

not necessarily our own choice often this is the default for the program and 

although we alter it the next time the program starts it delivers up the default 

font again when we start a new document. When I'm designing a workbook for 

others to use - which is quite often - I want it to look how the user wants it and 

in the font that they want. 

The easy way is of course to have my default font set to my preferences, not 

the preferences supplied by the designers (Microsoft in Excel‟s case). 

Changing the default font is pretty simple – but once changed it will remain the 

same in all future worksheets until changed again. 

This is for Office 2007 Users: 

Click on the Office Button 

Select Excel options button. 

In the area of the Popular settings select the When creating new workbooks 

The font typeface and size are shown here 

Change these to your requirements 

Click Ok and close the worksheet. 

When you open the worksheet the new font will be the default. 

 

Spell Check In Excel 

Excel is primarily for numeric data it‟s a number cruncher however, we often 

need to use a lot of words in Excel worksheets. Given that although I‟m not the 

worst speller in New Zealand I wouldn‟t enter spelling bees because I‟m not the 

best either! Given that statement it follows that typos and misspelled words 

occur in Excel also. 

It therefore should make sense to need to understand what cells the spell 

checker in Excel actually checks. Did you know that the spell checker actually 

checks is dependent on what you select before it starts? 

So, you‟d best know not only what the options are but how to set them and what 

they accomplish for you. 

If you‟ve selected the formula bar and start the spell checker. Excel will check 

just the contents of the formula bar, leaving the rest of the worksheet to a 

different check. 
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Select a range of cells an start the spell checker, only the selected cells in that 

range are checked. 

How we check an entire worksheet is done by selecting any cell on the sheet and 

starting the spell checker. 

When you have three or four sheets in a workbook that need checking then do 

the following. 

Select all the worksheets via their tabs.  

Use the Shift key or Ctrl key with the mouse to select all the sheets.  

Start the spell checker. 

from the information given it should be quite clear just what the spell checker 

in Excel is checking – don‟t take it for granted and never ASSUME anything with 

a computer or its programs.  

 

A Comment of a Different Color 

I use comments in Excel especially when designing sheets for other people or 

companies etc. Such things as notes made to myself about double checking a 

formula, or something relayed from the person the sheet is for.  

Whatever your own needs may be are you aware that you can change the color 

of these comments with just a couple a clicks. 

Once you've located a comment to be changed right-click on the border of it. 

 

  

 

 

 

 

 

 

 

 

 

 

 

Then choose Format Comment from the menu. 

When the dialog window opens choose the Colors and Lines tab. 

Then select the colour required. 

I‟ve selected Bright green. 

The comment background is then that colour  
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Picture It in Excel 2007 

Sometimes it‟s necessary to show an Excel worksheet or a relevant part of it 

but you do not require the recipients to change it. In other word what is wanted 

is a picture of the worksheet area that they are interested in. I bet I can hear 

most of you murmuring that‟s easy take a PrtScr of it and send it as a picture. 

Yes that is one way of doing it but that way you may need to go in and crop the 

picture and resave it in its cropped format, or whatever.  

But Excel is capable of doing this on its own so why go round the houses when 

we can knock at the door in the street? 

This is how to do it: 
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Highlight the cells that are needed in the picture. 

Now go to the Paste button in the Home tab of the ribbon.  

Hang on a minute we haven‟t copied anything yet we‟ve only highlighted the cells 

required. That‟s the beauty of this method the computer is going to do the work 

for us. 

Click the bottom half of the Paste button to display your pasting choices. 

 

 
 

Select As Picture and then Copy as Picture 

The dialog box below is displayed on screen. 

 

 
 

Use the option from the dialog box how you want your picture to look. Now you 

can paste the picture wherever you need it. I‟ve shown it below and you will see 

that it is indeed a picture of anly the information from the spreadsheet that I 

highlighted. The actual screen from a screenshot that has been cropped etc is 

below the method I used. It took twice as long to do and was much more hassle.  
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Method: 

Highlight, select Paste button, select downward pointing arrow, select As 

Picture, select Copy as Picture use the Dialog box   Done!    

 

Free Ms Office Templates 

http://www.klariti.com/free/templates.shtml 

 

I‟ve often found myself working on a project in MS Office and thought someone 

must have done this before – “Why isn‟t there a template and if there is wher 

can I find it?” 

I found it at the above site and they are free for anyone to use. All the normal 

things that you may want in the way of a template are there – you may need to 

adapt them to your own personal needs but the basics are usually the thing that 

take most of the time not the trimmings. This is not the only site to look at 

either look under Microsoft‟s own site.  

http://office.microsoft.com/en-us/templates/ 

Next time you want to make up a special document or a one off photo album 

make sure you check out the web before you start working away on re-inventing 

the wheel. 

 

Easy Upper and/or Lower Case 

Word and PowerPoint have the Change Case, which besides being useful in those 

applications could well be applied in Excel. Going through a spreadsheet changing 

the case of words can be a pain. But then Excel is not meant to be a word 

processor or a presentation application it‟s a number cruncher isn‟t it? 

There is a way that‟s quick and neat to change the case of words in Excel but 

it‟s not in the cell formatting where most people look for it – it‟s in the formula 

bar. 

Thes are the formulae you need. 

Without delay here they are: 

 

=UPPER(textlocation) returns all uppercase text. 

 

=LOWER(textlocation) returns all lowercase text. 

 

=PROPER(textlocation) returns all text with the first letter of each word as 

uppercase and all other characters as lowercase.  

 

Be warned these are not quite as easy to use as they look and there is a lot of 

learning to be done in how they work. 
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Calculations Using the Whole Row or Column 

 

Sometimes Excel rows or columns are designed in such a way that they need to 

expand in size as more data is added.  

How do you change the formula in an expanding row or column?  

OK you could change the cell range each time but that can get overlooked and 

tedious to do.. 

There are other ways of doing this but most of the normal; ones that people try 

or use are loaded with error traps. 

Could there or is there a simpler way to do this of course there is you only need 

to know how and following are the instructions for doing it. 

 

When writing any formula that needs the data in the whole column or row, use 

only its letter/number as both the beginning and ending locations. What does 

that mean? Exactly what I have said if you need the whole of column C added 

and you know that it‟s going to expand with more data in the future then use 

something like =Sum(A:A) 

 

Sounds confusing I know but wait - a quick example will clarify things immensely. 

 

If you wanted the average of data in column A:  

Move to the cell that the average has to be displayed in. 

Type in the formula. 

=AVERAGE(A:A) 

Sometimes this may be needed for an entire row, which can grow in the same 

way. Suppose this is row 10 then again: 

Move to the cell that the average has to be displayed in. 

Type in the formula. 

=AVERAGE(10:10) will average all data in row one. 

 

Unhide The ‘A’ Column and Row 1 

Once you have hidden the A Column or Row 1 in a spreadsheet it‟s the devil‟s own 

job to get them to be unhidden. The reason for this is that you highlight the 

Column to either side of the column to unhide. Column L and N and Rows 7 and 9 

to unhide column M and Row 8 respectively, but how do you highlight row 3 and 

minus (-1) or column B and the row to the left of A?   

This can be a frustrating problem when you don‟t know what to do and I‟ve seen 

many an operator in Excel nearly in tears trying to solve it. It‟s like the magician 

who knows the rabbit is in the hat but can‟t produce it on demand! 

There are possibly a number of solutions there‟s always more ways than one of 

killing the cat but the one I usually go for is the following. Dpon‟t hide column A 
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or Row 1 is the best solution of all but that is not always a possibility. 

What is the trick of highlighting two columns or rows? 

You highlight the first column by selecting it from the column letters row and 

drag across to highlight the second column. This is the same for selecting two 

or more rows to highlight, except you use the row numbers column. 

 

This diagram displays column A and C highlighted with 

Column B hidden. To unhide click the format button in 

the ribbon for Excel 2007 and click on Unhide – 

column B will then display. In Excel 2003 click the 

Format menu then the column and Hide. The same can 

be done in both versions for Row. 

Now let‟s look at the column A when it‟s hidden how to unhide it. 

 

Here column A has been hidden and the 

problem we have set ourselves is to unhide it. 

Look at the columns and highlight Colum B, 

what‟s to the left of column B? Only the 

column with the row numbers in it. Ok it‟s a 

column; not a useable one in the true sense of 

the word but let‟s highlight it anyway. Nothing 

ventured nothing gained.   

 

Now column B and the row number column have been 

highlighted – use the format menu and the unhide command 

and bingo the column A is on display again.  

 

 

 

 

 All three columns are highlighted with Column A 

displayed again. The same method can be used to hide and display Row 1 just 

highlight Row 2 and the Column name row and unhide Rows. Go and play with it 

and check it out you‟ll find out all sorts of things when you play with a program. 

I didn‟t wake up yesterday knowing the things that I know about computer 

applications – I played with them like a kid in a sand – pit building castles. 
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Now that you know the long way round why not try the shortcut? Why waste 

time clicking on menus especially trying to remember where they are in the 

ribbon? 

To hide column A click on the divisor between column A and B. You should see a 

small two pointed arrow. 

Right click and from the drop down menu click on Hide. 

Column A will now be hidden. 

Now let‟s unhide it. 

Click on the divisor between the Row number column and column B 

Notice the difference? 

  

 

 

Yes that‟s right this one has two vertical lines, but it works just the same. 

Right click it and click Unhide from the menu. 

How much simpler could it be? Go and try the same method on row 1. I‟m not 

going to do all the work for you. 
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